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Welcome to eBeam Presenter

eBeam Presenter from Electronics For Imaging is a software plug-in for the eBeam 
whiteboard appliance. eBeam Presenter captures meeting notes and diagrams as you create 
them on a whiteboard, then broadcasts them over the Internet or corporate intranet in real 
time. The eBeam Presenter plug-in for eBeam Moderator software gives you greater flexibility 
in sharing and annotating documents and whiteboard notes.

The eBeam Presenter plug-in allows the eBeam whiteboard appliance to synchronize users’ 
marker strokes on a board with sound while recording a meeting.

eBeam Presenter records whiteboard drawings and audio simultaneously. The two data streams 
are merged for playback via RealNetworks’ RealPlayer so that whiteboard images and recorded 
voices are in sync when the presentation is reviewed later.

Students who miss a class or coworkers who miss a meeting can hear a presentation and the 
related discussion, as well as see the notes and drawings, exactly as they appeared during the 
actual session.

In addition to creating a recorded presentation, you can broadcast the presentation live to an 
audience over the Internet. You can also publish your presentation on RealServer or a web 
server for on-demand viewing.

See also:

Features in this version

Installing eBeam Presenter

Using eBeam Presenter

Presentation pointers
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Features in this version

This version of eBeam Presenter allows you to do the following:

• Record whiteboard strokes, annotations, and audio.

• Play back a recorded presentation in RealNetworks’ RealPlayer 8 or later.

• Play back a recorded presentation using RealNetworks’ RealServer or a web server for 
on-demand viewing.

• Broadcast a live presentation via RealPlayer.

See also:

Installing eBeam Presenter

Using eBeam Presenter

Presentation pointers
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Installing eBeam Presenter

Installing eBeam Presenter is quick and easy. You can download eBeam Presenter from the web 
or install it from a CD-ROM.

System requirements

Installation procedures

Installing the eBeam Presenter file format plug-in for RealServer

See also:

Using eBeam Presenter

System requirements

The minimum system requirements for creating and viewing a presentation are as follows:

Creating a presentation

To create a presentation, you need the following:

• The eBeam system

• eBeam Moderator 2.0 or later software and the eBeam Presenter plug-in

• Windows-compatible PC with Pentium 200 MHz or faster processor

• Windows 95/98/NT/2000 or ME

• 32MB available RAM

• 6MB available hard disk drive space 

• SoundBlaster compatible sound card and a microphone (if your presentation includes audio)

• RealPlayer 8 or later, for previewing a presentation

Viewing a presentation

To view a presentation, your audience will need the following:

• A web browser with an Internet connection of 28.8 Kbps or faster (or a Local Area Network 
connection)

• Windows-compatible PC with Pentium 200 MHz or faster processor

• Windows 95/98/NT/2000 or ME

• Minimum 16MB available RAM

• SoundBlaster compatible sound card and speakers (if your presentation includes audio)
5



   
Publishing a presentation

To publish a live or on-demand presentation on a RealServer, you need the following:

• Access to a RealServer. Visit the RealNetworks’ website (www.realnetworks.com) for more 
information.

• RealServer information, such as the name or IP address of the server, the name of the 
directory on the server where your presentation is to be stored, etc. Obtain this information 
from your system administrator or Internet Service Provider.

• The eBeam Presenter file format plug-in installed on a RealServer for streaming your on-
demand presentation (not required for a live presentation). This file format plug-in is 
included in the eBeam Presenter installation and is also downloadable from the eBeam 
website (www.e-beam.com).

To publish your presentation on an HTTP web server, you need:

• Access to an HTTP web server where you can host your web page. If you are publishing a link 
to your presentation, the web server must have .SMI files registered as MIME type in order 
to properly launch RealPlayer.

• Web server information, such as the directory on the server where you want your 
presentation stored. Obtain this information from your system administrator or webmaster.
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Installation procedures

Before you install the eBeam Presenter plug-in, make sure you have installed the eBeam 
Moderator software (available from www.e-beam.com). You need to install the plug-in in the 
same location in which you install the eBeam Moderator software, so make a note of the 
directory in which you install eBeam Moderator.

If you installed eBeam Moderator using the default location in the installation program, install 
the eBeam Presenter plug-in in the same folder.

To install the eBeam Presenter plug-in:

1. Download the installation program, or insert the CD-ROM into your drive.

2. Close any other applications that may be open.

3. Double-click the installation program icon. If you are using a CD, the installation program 
launches when you insert the CD into the drive. If it does not, browse to your CD-ROM drive 
and double-click the Setup.exe file.

4. Follow the instructions of the Setup Wizard to complete the installation.

5. At the end of the installation, view the Readme.txt file for the latest information about this 
version of the eBeam Presenter.

See also:

System requirements

Using eBeam Presenter

Installing the eBeam Presenter file format plug-in for RealServer
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Installing the eBeam Presenter file format plug-in for 
RealServer

To make your presentations available from RealServer for on-demand viewing, you must install 
the eBeam Presenter file format plug-in on the RealServer that will host your presentation. You 
must put the plug-in in the RealServer plug-ins directory.

The RealServer plug-in is downloadable from www.e-beam.com and is also loaded on your PC 
when you install eBeam Presenter. The plug-in is in the eBeam Presenter\RealServer Plug-in 
folder. The eBeam Presenter folder is located in the Electronics For Imaging\eBeam 
2.0\Plugins folder. If you selected the default location in the installation program, these 
folders will be in the Program Files folder.

Copy the RealServer plug-in to the RealServer plug-ins directory. The RealServer plug-ins 
directory is generally configured as:

Program Files/Real/Realserver/Plugins

Contact your system administrator or RealServer administrator if you cannot locate the 
RealServer plug-in.

See also:

System requirements

Using eBeam Presenter

Installation procedures
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Using eBeam Presenter

The sections below describe how to use eBeam Presenter to create and view presentations. 

eBeam Presenter toolbar

Configuring eBeam Presenter

Starting a live presentation

Starting a recorded presentation

Publishing a presentation

See also:

Installing eBeam Presenter

Presentation pointers
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eBeam Presenter toolbar

You can access all eBeam Presenter’s functionality from the eBeam Presenter toolbar.

Launch eBeam Moderator. The eBeam Presenter toolbar appears at the bottom of the eBeam 
Moderator main window. If the toolbar is not visible, select eBeam Presenter from the 
View>Toolbar menu.

Recording - displays recording status information, such as elapsed time, available disk space, and audio level (if your 
presentation includes audio)

See also:

Configuring eBeam Presenter

Starting a live presentation

Starting a recorded presentation

Publishing a presentation

Logo - click to open the About eBeam Presenter window, which displays the version number

Configuration - opens the eBeam Presenter Configuration window, where you can select the 
type of presentation you want to create, whether you want to include audio, edit clip 
information, etc.

Record - start recording the presentation or start broadcasting a live presentation

Pause - pauses the recording presentation (not available for a live presentation)

Stop - stops the recording or live presentation

Play - play a previously/last recorded presentation in RealPlayer (not available while 
recording)
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Configuring eBeam Presenter

Click the Configuration button on the eBeam Presenter toolbar. The window below appears.

You can record a presentation or broadcast a presentation live over the Internet or a corporate 
LAN. You and the members of your audience must have access to RealServer in order to use the 
live presentation feature. To configure your presentation, see the following:

Configuring a live presentation

Configuring a recorded presentation

Creating a web page
11



         
Configuring a live presentation

1. Click the Configuration button on the eBeam Presenter toolbar.

2. Select Live Presentation.

3. Click Configure.

The RealServer settings window appears.
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4. Enter the following information (check with your system administrator or RealServer 
administrator if you are not sure what values to use):

• RealServer name or IP address to be used for your broadcast

• Encoder port to connect to (4040 is the default)

• Real Transport Streaming Protocol (RTSP) port (554 is the default)

• Mount point (/encoder is the default)

• User name and password for the server, if required

• It is recommended you use a UDP (User Datagram Protocol) connection method if you 
are not behind a firewall. Otherwise, connect via TCP/IP

• Select the Record presentation for later viewing check box to record a presentation 
on your computer for later viewing (note that the presentation is stored locally on your 
computer, not on RealServer)

• Select Create Web Page to create a web page that you or your audience can use to 
connect to the live presentation. (For more information, see Creating a web page). Click 
Configure to set up the layout of the web page.

5. Click OK to return to the main Configuration window.

6. To include audio in your presentation, select the Use Audio check box and indicate a 
connection speed at which to optimize the audio portion of the presentation for your 
audience. 

Consider the connection speed of your audience. Keep in mind they may be using a lower-
speed modem than you, or may be connected over a high-speed network. If you are 
recording a live presentation, the greater the bandwidth you choose, the larger the 
presentation file.

7. Enter a filename and directory path for your presentation file in the Output section of the 
Configuration window.

Several files will be created to assist you and your audience in joining the live presentation. 
(For more information, see Publishing a live presentation). The filename you enter is used 
as a base filename for all your presentation files, and as the stream name on RealServer.
13



      
8. Click Edit and enter the following information about your presentation in the Clip 
Information configuration window.

• Title: title of the clip

• Author: name of the clip's creator

• Copyright: year and owner of the clip's copyright

• Description: a brief summary of the clip's content

9. Click OK.

The information you entered is displayed in the Clip Information section of the Configuration 
window. To edit this information, click Edit, re-enter the information, and click OK. 

10. Click OK to return to the eBeam Presenter toolbar.

The About this Presentation dialog box in RealPlayer displays clip information to your 
audience when they view a presentation. To access this information, choose Help>About 
this Presentation.

See also:

Publishing a live presentation

Configuring a recorded presentation

Creating a web page

Starting a live presentation
14



               
Configuring a recorded presentation

1. Click the Configuration button on the eBeam Presenter toolbar.

2. Select Recorded Presentation.

3. Click the Configure button.

4. To publish your presentation on RealServer for on-demand viewing, select the Use this 
presentation on a RealServer check box.

5. Enter the following information (check with your system administrator or RealServer 
administrator if you are not sure what values to use).

• RealServer name or IP address that will host your presentation files

• Real Transport Streaming Protocol (RTSP) port (554 is the default)

• Directory on RealServer in which to store your presentation files. Your system 
administrator or RealServer administrator may have assigned you a specific subfolder on 
the RealServer for your organization.

6. Select Create Web Page to create a web page that you or your audience can use to play 
back the recorded presentation. Click Configure to set up the layout of the web page. (For 
more information, see Creating a web page). 

7. Click OK to return to the main Configuration window.

8. To include audio in your presentation, select the Use Audio check box and a connection 
speed at which to optimize the audio portion of the presentation for your audience.

Consider the connection speed of your audience. Keep in mind they may be using a lower-
speed modem than you, or may be connected over a high-speed network. The greater the 
bandwidth, the larger the presentation file.

9. Enter a filename and directory path for your presentation files in the Output section of the 
Configuration window.
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Several files will be created to assist you and your audience in the playback of a recorded 
presentation. (For more information, see Publishing a presentation).

10. Click Edit, and enter the following information about your presentation in the Clip 
Information configuration window.

• Title: title of the clip

• Author: name of the clip's creator

• Copyright: year and owner of the clip's copyright

• Description: a brief summary of the clip's content

11. Click OK.

The information you entered appears in the Clip Information section of the Configuration 
window. To edit this information, click Edit, re-enter the information, and click OK. 

12. Click OK to return to the eBeam Presenter toolbar.

The About this Presentation dialog box in RealPlayer displays clip information to your 
audience when they view a presentation. To access this information, choose Help>About 
this Presentation.

See also:

Publishing a recorded presentation

Starting a recorded presentation

Publishing a presentation for on-demand viewing

Configuring a live presentation

Creating a web page
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Creating a web page

One way your audience can view a presentation is through a web page; the other way is for you 
to send the presentation .SMI file as an e-mail attachment. For more information, see 
Publishing a presentation.

To create a web page, click the Configure button in either the RealServer Settings window or 
the On-Demand View Settings window.

Decide on a playback method for your presentation. Do you want the RealPlayer to pop-up as a 
separate window, or do you want an embedded RealPlayer as part of the web page?

If you choose to include an embedded RealPlayer, select the controls you want included as part 
of the RealPlayer. If you select the Auto Start check box, the presentation plays as soon as the 
web page loads.

See also:

Configuring eBeam Presenter

Starting a live presentation

Starting a recorded presentation

Publishing a presentation
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Starting a live presentation

Once you have configured your live presentation, you are ready to start recording. Click the 
Record button on the toolbar.

You will be prompted to start recording a particular Moderator meeting. You may have more 
than one Moderator meeting window open, but you can broadcast information in only one 
Moderator meeting window. Select the meeting window you want to use before you start to 
record. All previously generated information in the meeting window is ignored. Only the 
information added after you start a broadcast is included.

eBeam Presenter will try to connect to the RealServer. If it successfully connects, you see Live 
in the status window, and the audio meter responds to your voice (if you have selected to 
include audio as part of your presentation). The timer in the status window starts, indicating 
how long your presentation has been broadcasting live.

When you are finished, click Stop. The Pause button is disabled during the live broadcast.

See Presentation pointers for more information on configuring your presentation and for 
pointers on what you can and cannot do during the presentation.

Start your live presentation approximately 10 minutes earlier than your intended start time. 
This gives you plenty of time to prepare for the presentation, and ensures that your audience 
will be able to connect to the presentation.

The presentation files that assist your audience in joining the presentation are created after you 
start recording. To use these files in advance of the scheduled presentation time, you can start 
a presentation at any time and stop after a few seconds. See Publishing a presentation for more 
information on using the various files that are created for your presentation.

See also:

Publishing a presentation

Presentation pointers

Starting a recorded presentation
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Starting a recorded presentation

Once you have configured your recorded presentation, you are ready to start. Click the Record 
button on the toolbar.

You will be prompted to start recording a particular Moderator meeting. You may have more 
than one Moderator meeting window open, but you can record information in only one 
Moderator meeting window. Select the meeting window you want to use before you start to 
record. All previously generated information in the meeting window is ignored. Only the 
information added after you start recording is included.

If a previously recorded presentation exists in the same location as specified in your 
configuration, you will be asked to replace that presentation. If you choose to replace the 
presentation, it will be removed. You will not be able to recover it. You are given the option to 
change your configuration settings before you start recording.

After a few seconds, you see Recording in the status window and the audio meter responds to 
your voice (if you have selected to include audio as part of your presentation). The timer in the 
status window starts, indicating how long you have been recording.

Keep an eye on the available disk space, which is displayed on the toolbar. Recording audio uses 
much more disk space than recording whiteboard information.

You can use the Pause button to pause your presentation. The status window displays a 
blinking Paused message. Note that no audio or whiteboard information is recorded during a 
pause. To resume recording, click Record.

When you are finished, click Stop. A window appears displaying information about your 
presentation (start/end time, duration, output location, etc.). You are given the option to play 
back the recorded presentation. If you choose to play your presentation, RealPlayer starts.

Several files are created to assist you in playing back a recorded presentation and publishing 
your presentation for on-demand viewing. See Publishing a presentation for more information 
on using the various files that are created for you.

To play a previously recorded presentation, click the Play button on the toolbar. Note that this 
only plays the last recorded presentation. To play an earlier presentation, open its .SMI file from 
within RealPlayer, or double-click the .SMI file from Windows Explorer.

See Presentation pointers for more information on setting up your presentation and pointers on 
what you can and cannot do during the presentation.

See also:

Publishing a presentation

Presentation pointers

Starting a live presentation
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Publishing a presentation

Several files are created to allow your audience to view your presentation. You can publish 
these files to your RealServer or to a web server.

See:

Publishing a recorded presentation

Publishing a presentation for on-demand viewing

Publishing a presentation on a web server

Publishing a live presentation

See also:

Configuring eBeam Presenter

Publishing a recorded presentation

After you record a presentation, a folder with the Filename you specified in the Output section 
of the Configuration window is created. The default location in the configuration is 
C:\eBeamPresentation, which is used in the following examples.

The files are stored in the following directory structure:

See also:

Publishing a presentation for on-demand viewing

Publishing a presentation on a web server

Publishing a live presentation

Folder/File Comments

c:\eBeamPresentation Main presentation folder

\Content Subfolder containing recorded presentation files

\Content\eBeamPresentation.rm Recorded audio

\Content\eBeamPresentation.wbs Recorded whiteboard information

\Content\eBeamPresentation_Test.smi .SMI file for local play back with RealPlayer.

\OnDemand Subfolder containing files for publishing on-demand 
presentations on a RealServer or a web server. This folder is 
created only if you selected the Use this presentation on a 
RealServer check box in the On-Demand View Settings 
configuration window.

\OnDemand\eBeamPresentation.smi SMIL file for playing back the presentation from the RealServer 
or a web server.

\OnDemand\eBeamPresentation.html HTML page that plays back a presentation published on a 
RealServer. This file is only created if you selected the Create 
Web Page check box in the On-Demand View Settings window 
during configuration (see Creating a web page).
20



Previewing a local presentation

After you record a presentation, you can play it by double-clicking the _Test.SMI file or by 
selecting the filename in the RealPlayer File>Open File menu. Note that all the presentation 
files (.RM, .WBS, and .SMI) must be stored in the same folder.

See also:

Publishing a recorded presentation

Publishing a presentation for on-demand viewing

Publishing a presentation on a web server

Publishing a live presentation

Publishing a presentation for on-demand viewing

To publish a presentation for on-demand viewing, you (or your system administrator) must 
copy the .RM and .WBS files from the Content folder to the RealServer. Note that all these files 
must be located in the same directory on the RealServer, and that the directory on the 
RealServer should be the same directory you entered in the On-Demand View Settings 
configuration window during configuration.

You can make your presentation available to your audience from a web page, or my e-mailing 
the .SMI file located in the OnDemand folder. Users can double-click the file or open it from 
RealPlayer.

To create a web page, you must copy the HTML file and the .SMI file located in the OnDemand 
folder to your web server. Your audience can then view your on-demand presentation with a 
URL similar to the following (replace with appropriate server and directory names): 

http://www.myserver.com/mydir/eBeamPresentation.html

You can also use this link, or integrate the HTML source, in other web pages. 

See also:

Publishing a recorded presentation

Publishing a presentation on a web server

Publishing a live presentation
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Publishing a presentation on a web server

Alternatively, you can publish your presentation on a web server instead of a RealServer, but 
keep in mind that a web server is not as robust and does not perform all of the features of a 
RealServer.

To publish your presentation on a web server, you need the following information from your 
system administrator or web master:

• Web server name or IP address to be used to host your presentation

• Directory on the web server where you want your presentation files filed

• URL of the web page

You need to copy the .RM, .WBS, and .SMI files to the web server. You will also need to edit the 
.SMI file (use any text editor) to point to the presentation files located on your web server. For 
example, change

audio src = "rtsp://realserver:554/eBeamPresentation_content/eBeamPresentation.rm"

ref src = "rtsp://realserver:554/eBeamPresentation_content/eBeamPresentation.wbs"

to

audio src = "http://webserver/directory/eBeamPresentation.rm"

ref src = "http://webserver/directory/eBeamPresentation.wbs"

You can then create a link in your web page pointing to the .SMI file.

See also:

Publishing a recorded presentation

Publishing a presentation for on-demand viewing

Publishing a live presentation
22



Publishing a live presentation

When you start a live broadcast, a folder with the filename you specified in the Output section 
of the configuration window is created in the directory. The default location in the configuration 
is C:\eBeamPresentation, which is used in the following examples.

The files are stored in the following directory structure:

You can make your live presentation available to members of your audience from a web 
page, or by e-mailing the .SMI file located in the Live folder. A user can either double-
click the file or open it from RealPlayer.

If you opted to create a web page, you need to copy the HTML file and .SMI file located in the 
Live folder to your web server. Your audience can then view the live presentation using a URL 
similar to the following (replace with appropriate server and directory names): 

http://www.myserver.com/mydir/eBeamPresentation.html

You can also use this link, or integrate the HTML source, in other web pages. 

If you opted to record the live presentation, see Publishing a recorded presentation.

Make sure you start your presentation 10-15 minutes before the actual start time, so you can 
update your web server or send the .SMI file to your audience. If you need the .SMI and HTML 
well in advance of your live broadcast, start a “temporary” broadcast and use those files. (If 
you do this, make sure you use the same configuration information you will use for the actual 
live broadcast).

See also:

Publishing a recorded presentation

Publishing a presentation for on-demand viewing

Publishing a presentation on a web server

Folder/File Comments

c:\eBeamPresentation Main presentation folder

\Content Subfolder containing recorded presentation files. This folder is 
empty unless you have chosen to record the live broadcast, in 
which case the contents are the same as when recording a 
presentation.

\Live Subfolder containing the files that allow your audience to join 
the live presentation.

\Live\eBeamPresentation.smi .SMI file for joining a live presentation

\Live\eBeamPresentation.html HTML page for a web server to join a live presentation. This file 
is only created if you select the Create a Web Page check box 
in the RealServer Settings window during configuration. See 
Creating a web page.
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Presentation pointers
• Plan ahead

Plan your network and server needs well in advance, so that when you are ready to broadcast 
your presentation, you have everything configured properly. Consult your system administrator 
or RealServer administrator and gather all necessary information.

• Remember your audience

Because your audience is remote, be extra careful when writing on the whiteboard, so that the 
information you record is clear. Press firmly on the whiteboard with the eBeam marker.

If you are use a microphone, speak clearly and concisely, so that your message is understood.  
Do a test recording to adjust the microphone volume according to the distance the microphone 
is from your mouth. You can adjust the microphone and speaker levels from your Windows 
volume control interface.

Let your audience know when the meeting will begin; let them know well in advance.

A few more things to keep in mind…

• The Pause button is disabled when you are broadcasting a live presentation.

• Only new marker and annotation strokes are recorded; any writing or drawing that was on 
the whiteboard before you started recording is not included in the presentation.

• Only the annotations created on the last page of Moderator are recorded.

• The annotation Undo and Redo functionality in Moderator has no effect on the recorded 
strokes.

• In a shared meeting in Moderator, only your whiteboard and annotation strokes are 
recorded.

• When you record a presentation, you will not get a warning of low or insufficient disk space.  
If you are recording audio, remember that the amount of disk space used is much greater 
than the space used to record whiteboard information.

• You can only record information in one Moderator meeting window. Select the meeting 
window you want to use before you start to record. You cannot change this during the 
recording.

• If you are broadcasting a live presentation, there is a few seconds delay between your 
broadcast and what is happening in real time.

• During a live presentation, your audience will not be able to view or hear any part of the 
presentation that took place prior to them joining the presentation. You can record the live 
presentation and make it available later for on-demand viewing.

• In order to view a presentation, you must first install the eBeam Presenter RealPlayer plug-in 
in RealPlayer. The first time you play an eBeam presentation file or join a live presentation, 
RealPlayer automatically installs the plug-in from the RealNetworks server, or asks you to 
follow installation instructions. Once the plug-in is installed, RealPlayer will not prompt you to 
do this again unless a newer version is released.
24



Glossary

LAN 
(Local Area Network)

A group of computers and other devices dispersed over a 
relatively limited area and connected by a communications link 
that enables any device to interact with any other device on 
the network. LANs commonly include microcomputers and 
shared resources, such as laser printers and large hard disk 
drives.

RealNetworks A company that creates hosting solutions for the delivery of 
streaming presentations to an online audience.

RealServer A software product created by RealNetworks that allows you to 
stream live or recorded RealAudio and RealVideo files to 
anyone using RealPlayer. The server can work with web servers 
to stream media over the Internet or to users on a corporate 
intranet.

RealPlayer Allows your audience to view your recorded and live 
presentations. RealPlayer is available from RealNetworks.

SMIL 
(Synchronized Multimedia Integration Language)

Files that organize the way RealPlayer plays back your 
presentation files.

UDP 
(User Datagram Protocol)

A connectionless network protocol. It is used for broadcasting 
messages over a network. If you are not behind a firewall, you 
should use the UDP connection.

TCP/IP 
(Transmission Control Protocol 
and Internet Protocol)

Transport and address networks protocols. TCP is used to 
establish a connection for data transmission. IP defines the 
method for sending the data in packets. 

Server An application that responds to requests from another 
application or task

RTSP 
(Real-Time Streaming Protocol)

An application-level protocol for controlling the delivery of data 
with real-time properties. RTSP provides an extensible 
framework to enable controlled, on-demand delivery of real-
time data, such as audio and video, using the Transmission 
Control Protocol (TCP) or the User Data Protocol (UDP).
25



Copyright Notice

Copyright © 2001 Electronics For Imaging, Inc. All rights reserved.

This publication is protected by copyright, and all rights are reserved. No part of it may be 
reproduced or transmitted in any form or by any means for any purpose without express prior 
written consent from Electronics For Imaging, Inc. except as expressly permitted herein. 
Information in this document is subject to change without notice and does not represent a 
commitment on the part of Electronics For Imaging, Inc.

The software described in this publication is furnished under license and may only be used or 
copied in accordance with the terms of such license. 

Trademarks 

eBeam, e-Beam, eBeam Mouse, eBeam Moderator, eBeam Presenter, and ImagePort are 
trademarks of Electronics For Imaging, Inc.  Microsoft, MS, Windows, and Windows NT are 
registered trademarks or trademarks of Microsoft Corporation in the United States and/or other 
countries.  Pentium is a registered trademark or trademark of the Intel Corporation in the 
United States and/or other countries.

All other terms and product names may be trademarks or registered trademarks of their 
respective owners, and are hereby acknowledged.

ELECTRONICS FOR IMAGING, INCORPORATED END-USER LICENSE AGREEMENT YOU SHOULD 
CAREFULLY READ THE FOLLOWING TERMS AND CONDITIONS BEFORE USING THIS 
SOFTWARE. IF YOU DO NOT AGREE TO THE TERMS AND CONDITIONS OF THIS AGREEMENT, 
DO NOT USE THE SOFTWARE. INTALLING OR USING THE SOFTWARE INDICATES THAT YOU 
AGREE TO AND ACCEPT THE TERMS OF THIS AGREEMENT.

LICENSE: Electronics for Imaging, Inc. (“EFI”) grants you a non-exclusive license to use the 
software (“Software”) and accompanying documentation (“Documentation”) on any computer, 
provided that the Software is used only in connection with the eBeam™ product (“Product”) you 
have obtained, subject to the terms and restrictions set forth in this Agreement. The Software 
is licensed, not sold.

You may use the Software solely for your own customary business or personal purposes and 
solely in connection with the Product. You may permanently transfer all of your rights under this 
Agreement only as part of a sale or transfer of the Product, provided you retain no copies, you 
transfer all of the Software and Documentation (including all component parts, the media and 
printed materials, any upgrades, and this Agreement), AND the recipient agrees to the terms of 
this Agreement. If the Software is an upgrade, any transfer must include all prior versions of 
the Software.

You may not make or have made, or permit to be made, any copies of the Software or portions 
thereof, except as necessary for backup or archive purposes in support of your use of the 
Software as permitted hereunder. You may not copy the Documentation. You may not attempt 
to alter, disassemble, decrypt or reverse engineer the Software. You may not lease or rent the 
Software.

PROPRIETARY RIGHTS: You acknowledge that the Software and Trademarks are proprietary to 
EFI and its suppliers and that title and other intellectual property rights therein remain with EFI 
and its suppliers. Except as stated above, this Agreement does not grant you any right to 
patents, copyrights, trade secrets, trademarks (whether registered or unregistered), or any 
other rights, franchises or licenses in respect of the Software or Trademarks. You may not adapt 
or use any trademark or trade name which is likely to be similar to or confusing with that of EFI 
or any of its suppliers or take any other action which impairs or reduces the trademark rights of 
EFI or its suppliers.



CONFIDENTIALITY: You agree to hold the Software in confidence, disclosing the Software only 
to authorized users having a need to use the Software as permitted by this Agreement and to 
take all reasonable precautions to prevent disclosure to other parties.

REMEDIES AND TERMINATION: Unauthorized use, copying or disclosure of the Software, 
Trademarks or any breach of this Agreement will result in automatic termination of this license 
and will make available to EFI other legal remedies. In the event of termination, you must 
destroy all copies of the Software and all of its component parts. All provisions of this 
Agreement relating to disclaimers of warranties, limitation of liability, remedies, or damages, 
and EFI’s proprietary rights shall survive termination.

LIMITED WARRANTY AND DISCLAIMER: EFI warrants to the original purchaser (“Customer”) for 
ninety (90) days from the date of original purchase from EFI or its authorized retailer that the 
Software will perform in substantial conformance to the Documentation. EFI warrants the 
media containing the Software against failure during the above warranty period. EFI makes no 
warranty or representation that the Software will meet your specific requirements, that the 
operation of the Software will be uninterrupted or error free, or that all defects in the Software 
will be corrected.

EXCEPT FOR THE ABOVE EXPRESS LIMITED WARRANTY, EFI MAKES AND YOU RECEIVE NO 
WARRANTIES OR CONDITIONS ON THE SOFTWARE, EXPRESS, IMPLIED, STATUTORY, OR IN 
ANY OTHER PROVISION OF THIS AGREEMENT OR COMMUNICATION WITH YOU, AND EFI 
SPECIFICALLY DISCLAIMS ANY IMPLIED WARRANTY OR CONDITION OF MERCHANTABILITY OR 
FITNESS FOR A PARTICULAR PURPOSE. 

LIMITATION OF LIABILITY: IN NO EVENT WILL EFI OR ITS SUPPLIERS BE LIABLE FOR ANY 
DAMAGES, INCLUDING LOSS OF DATA, LOST PROFITS, COST OF COVER OR OTHER SPECIAL, 
INCIDENTAL, CONSEQUENTIAL OR INDIRECT DAMAGES ARISING FROM THE SALE, 
INSTALLATION, MAINTENANCE, USE, PERFORMANCE OR FAILURE OF THE SOFTWARE, 
HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY. THIS LIMITATION WILL APPLY EVEN IF 
EFI HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. YOU ACKNOWLEDGE THAT 
THE PRICE OF THE PRODUCT REFLECTS THIS ALLOCATION OF RISK. BECAUSE SOME 
JURISDICTIONS DO NOT ALLOW THE EXCLUSION OR LIMITATION OF LIABILITY FOR 
CONSEQUENTIAL OR INCIDENTAL DAMAGES, THE ABOVE LIMITATION MAY NOT APPLY TO YOU.

EXPORT CONTROLS: You agree that you will not export or re-export the Software in any form in 
violation of any applicable laws or regulations of the United States or the country in which you 
obtained them.

GOVERNMENT USE: Use, duplication or disclosure of the Software by the United States 
Government is subject to restrictions as set forth in subdivision (c) (1) (ii) of the Rights in 
Technical Data and Computer Software clause at DFARS 252.227-7013 or in subparagraphs (c) 
(1) and (2) of the Commercial Computer Software—Restricted Right Clause at 48 CFR 52.227-
19, as applicable.

GENERAL: the laws of the State of California govern this Agreement. You agree that this 
Agreement shall not be subject to the United Nations Convention on Contracts for the 
International Sale of Goods (1980).  This Agreement is the entire agreement held between us 
and supersedes any other communications or advertising with respect to the Software. If any 
provision of this Agreement is held invalid, the remainder of this Agreement shall continue in 
full force and effect.

Electronics for Imaging
303 Velocity Way
Foster City, CA 94404
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